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Welcome!

The EPSON Stylus® C82 printer is the ideal desktop printer for business and home 
use. With its exceptional speed and print resolutions, it is practical for everyday use, 
yet capable of delivering when you need superior printing. It provides you with these 
advanced features:

■ EPSON’s exclusive DuraBrite™ inks. These quick-drying inks are resistant to 
water and fading, so prints stand the test of time. Because these ink particles 
remain near the surface and don’t bleed through, they’re ideal for double-sided 
prints. 

Note: The light resistance of prints is rated up to 70 years based on accelerated 
testing of prints on EPSON special media, displayed indoors, under glass. Actual 
print stability will vary according to media, printed image, display conditions, 
light intensity, humidity, and other atmospheric conditions. EPSON does not 
guarantee the longevity of prints. For maximum print life, display all prints under 
glass or lamination or properly store them.

■ Speeds of up to 22 pages per minute for black text printing

■ Resolution Performance Management™ (RPM) technology, which optimizes the 
number and placement of ink droplets on various media. Delivers superior photo 
quality with manageable print file sizes.

■ Exif (Exchangeable Image File) Print format support. This international standard 
ensures the accurate reproduction of your digital camera images. Most digital 
cameras store Exif Print information, such as shutter speed, metering, flash, and 
exposure settings, in the JPEG image file. Your printer, with EPSON Software™ 
Film Factory,™ uses these settings to create accurate prints.
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About Your Software

The CD-ROM that came with your printer includes all the software you need for 
printing. See the Start Here sheet for installation instructions.

■ Your printer driver runs your printer and lets you control how your documents 
look. You can’t print without it. 

Tip: It’s a good idea to check EPSON’s support web site periodically for free 
updates to your printer driver. Visit http://support.epson.com. Download 
instructions are posted for your convenience.

■ Your bonus software includes these great tools:

EPSON Software™ Film Factory™ is a photo management 
program that lets you organize, beautify, and print your photos 
in a flash. Supports Exif Print (except with Mac® OS X).

Note: With Exif Print, special image settings such as white balance, 
contrast, color saturation, and exposure time are saved in your 
digital photo files. If your digital camera supports Exif Print, you can 
use this technology when you print with Exif Print enabled 
applications such as EPSON Software Film Factory.

■ Your EPSON Printer Information Center gives you quick, 
on-screen access to information about your printer. It includes 
EPSON Print Show, animated tutorials on loading special paper, 
replacing ink cartridges, and other tasks. It also includes your 
on-screen Reference Guide for additional information about your 
printer. (The desktop icon may be different on some Mac® OS X 
systems.)

■ EPSON PhotoCenter  is EPSON’s free photo-sharing web site 
where you can store, organize, and share your photos; print 
high-resolution photos straight from the web; and create free online 
postcards with your photos. Your printer software installer lets you 
add a link to the EPSON PhotoCenter on your desktop.

SM
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About Your Documentation

To set up your printer, see the Start Here sheet. You’ll also find information on the 
Start Here sheet for installing the printer software for Windows® XP, Windows Me, 
and Windows 98, and Macintosh® OS 8.6 to 9.x.

This book contains system requirements, important safety information, your 
warranty, and instructions on:

■ Using the EPSON Printer Information Center

■ Printing with Windows or on a Macintosh

■ Maintaining the printer

■ Solving basic problems

■ Installing printer software on Windows 2000, Windows 95, Windows NT 4.x, 
and Macintosh OS X

Please follow these guidelines throughout:

Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your equipment.

Notes contain important information about your printer.

Tips contain hints for better printing.

For more details about your printer, use your EPSON Printer Information Center, 
described in the next section. 
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Using the EPSON Printer Information 
Center

Need help loading special paper, replacing ink cartridges, or cleaning the print head? 
Use the EPSON Printer Information Center (EPIC) to view printer movies that 
quickly tell you how. EPIC also includes an on-screen Reference Guide with additional 
printer details. If you haven’t installed the EPSON Printer Information Center, 
follow the instructions on the Start Here sheet or beginning on page 53 of this 
manual.

Note: You need a browser—such as Microsoft® Internet Explorer® 4.0 or later or 
Netscape Navigator® 3.0 or later—to view the manual. If you are using a different 
browser, the pages may not display correctly. 

Launching the Movies

1. Double-click the EPSON Printer Information Center icon on your desktop. 
(The desktop icon may be different on some Mac OS X systems.)

2. Click Print Show.

3. Click the appropriate topic, then click the title of the movie you want to watch. 

Use the program tools to pause a movie, replay a step, or skip ahead.

4. Click Exit to exit Print Show.

Click a topic, 
then click a 
title on the 
next screen
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Launching the Manual

1. Double-click the EPSON Printer Information Center icon on your desktop. 

2. Click Reference Guide. You see this screen:

3. Click a topic on the left to expand the table of contents. 

4. Click on the topic you want to view.

■ Click right arrows  to view subtopics, then click on a topic.

■ Click down arrows to close a subtopic list.

Note: If you see an icon for a graphic when viewing your Reference Guide in 
Netscape Navigator, click the Reload button to load the graphic.

Click here to 
expand the table 
of contents

Closed list, 
click to expand

Click to go 
to a topic
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Printing from Start to Finish

Here’s what to do to print a basic document—such as a photograph or newsletter—
from loading the paper to selecting print settings to controlling the print job. Follow 
the instructions in these sections:

■ “Loading Paper” below

■ “Printing with Windows” on page 10

■ “Printing on a Macintosh” on page 15

■ “Selecting the Correct Paper Type” on page 23

Loading Paper

You can load up to 150 sheets of plain paper in your printer’s sheet feeder.

1. Fan the stack of paper and place it against the right edge guide. Don’t push the 
paper in.

2. Slide the left edge guide against the paper, but not too tightly.

3. Pull out the output tray extensions. 

Slide the left edge 
guide against the 
paper

Don’t load paper 
above this arrow
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Follow these guidelines when loading paper:

■ Don’t load paper above the arrow on the left edge guide.

■ Load the printable side face up. It’s usually whiter or brighter than the other side.

■ Always load the short edge first, even when printing in landscape mode.

■ Load letterhead or preprinted paper into the printer top edge first.

■ If you experience paper feeding problems, try loading fewer sheets.

For instructions on using special media, see on-screen Reference Guide, or double-click 
the  EPSON Printer Information Center on your desktop to watch your printer 
movies.

Loading Envelopes

You can load up to 10 envelopes at a time. Follow these steps:

1. Load the envelopes short edge first against the right edge of the sheet feeder. The 
printable side should be up, and the flap side should be down and on the left. 
Slide the left edge guide against them. 

Make sure 
the flap side 
is on the left

Load with the printable 
side up and the flap side 
down
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2. Move the thickness lever on the side of the printer to the ^ position. (Remember 
to move the thickness lever back to the m position when you’re done.) 

3. Before you print, make these settings:

■ For Orientation, select Landscape (for OS X, select the middle icon in the 
Orientation section of the page setup dialog box).

■ For paper Type (Windows) or Media Type (Macintosh), select Plain Paper.

■ Choose the correct envelope size as the paper Size (Windows) or Paper Size 
(Macintosh). The most common envelope size is Envelope #10.

See page 10 (Windows) or page 15 (Macintosh) for more information about making 
printer software settings.
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Printing with Windows

This section describes the basic steps for printing with Windows. Make sure you have 
paper in the printer, as described on page 7. After you create your document in a 
software program, follow these steps to print:

1. From the File menu, click Print. You see your application’s Print dialog box (your 
dialog box may look different):

2. Make sure your EPSON Stylus C82 printer is selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or 
Options button, click it. Then click Properties or Preferences on the next 
screen.)

Note: If you click the print icon on your application’s toolbar instead of selecting 
Print from the File menu, you may not get the option to change the printer 
software settings before printing.

Click here to open 
your printer software

Select your printer here
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You see the Main menu of your printer settings dialog box.

4. Select the type of document you’re printing:

■ Draft: For rough drafts on plain paper. Saves ink.

■ Text: For text-only documents, like letters or reports. Delivers high-quality 
text printing.

■ Text & Image: For documents that have both text and images, like 
newsletters.

■ Photo: For photos and graphics, when you want good quality with faster 
printing.

■ Best Photo: For photos or graphics, when you need highest quality printing.

5. Choose the type of paper you’re printing on (click 
the arrow to scroll through the Type list). If 
you’re not sure which setting to select, see 
page 23.

1 Choose your 
document type

2 Choose your 
paper type . . .

3 and paper size

4 Click here
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6. You can also make these settings:

■ PhotoEnhance: Improves the appearance of low-resolution and improperly 
exposed photos.

■ Reverse Order: Prints your document so that the pages are in the right order 
when you retrieve them from the paper tray.

■ Print Preview: Lets you see what your printout will look like before you 
print.

Tip: For more information about printer settings, click the or Help button.

7. If you’re done, click OK to return to the Print dialog box and print, or . . .

Click the Layout tab at the top of the window to make various layout settings: 

8. Click OK to return to the Print dialog box and print.

Click to rotate your 
image 180°

Click to invert your 
image

Click to print on both 
sides of the page

Click to reduce 
or enlarge your 
document

Click the arrow 
to create a 
watermark

Select multiple 
page layouts or 
print a poster

Click to increase the printable 
area of your page

Click to center your 
image or text on 
the page
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During printing, this window appears and shows the progress of your print job. You 
can use the buttons to cancel, pause, or restart printing. You can also see how much 
ink you have left.

Note: You can also press the printer’s ) button to cancel a print job in progress.

Selecting the Settings You Use Most Often

Your printer settings apply only to the application you’re currently using. If you 
usually print one type of document in different applications—for example, color 
flyers on letter-size paper—you can change the default printer settings for all your 
programs.

1. Right-click the  printer icon on your taskbar (in the lower right corner of your 
screen).

2. Select Printer Settings. You see the Main menu of your printer settings dialog 
box, as shown on page 11.

3. Select the default settings you want to use for all your applications. Click OK 
when you’re finished.

Remember that you can always change the settings in your program when you want to 
print different types of documents. 

Click to cancel printing

Click to pause or resume 
printing

Shows ink levels 
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Customizing Windows Print Settings

You can use advanced settings for color matching, printing at a higher resolution, or 
selecting a variety of special effects.

1. On the Main tab, click the Advanced button in the bottom right corner of the 
window. The Basic settings change to the Advanced settings.

2. Select the following advanced settings as necessary:

3. Once you’ve finished selecting advanced settings, you can:

■ Click OK to save your settings, return to the Print dialog box, and print.

■ Click the Basic button to return to the Basic settings.

■ Click Save Setting to save your custom settings for future use. Then click 
OK to return to the Print dialog box and print.

Note: For more information about advanced settings, or instructions on saving 
them as a group so you can reuse them later, click the Help or button. If you 
want to use the Advanced screen each time you access your printer settings, 
select the Show this screen first checkbox.

Click here to select 
a paper type

Click here to select 
print quality; includes 
Photo RPM, which 
gives the best results 
on photo and glossy 
paper types

Click to improve 
the clarity of 
low-resolution images

Select a color 
management 
method, or change 
the Gamma setting

To choose No Color 
Adjustment, click 
ICM first
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Printing on a Macintosh

After you create your document in a software program, follow the steps in one of these 
sections to print:

■ For Macintosh OS 8.6 to 9.x applications, see the next section.

■ For Macintosh OS X applications, see page 18.

Printing with OS 8.6 to 9.x

Before you begin, make sure you selected your printer in the Chooser as described on 
the Start Here sheet.

1. From the File menu, select Page Setup. You see this dialog box:

2. Make sure you see C82 Series at the top of the dialog box. This indicates that 
your printer is active. If you don’t see it, select your printer in the Chooser.

3. Select the correct Paper Size and Orientation. You can also make these settings:

■ Customize: Lets you define a custom paper size.

■ Rotate by 180°: Rotates the image 180° on the page.

■ Double-Sided Printing: Lets you print on both sides of the page.

■ Reduce or Enlarge: You can reduce your print size to 25 percent of its 
original size, or enlarge it to 400 percent.

Make sure you see 
C82 Series

Select your paper size

Select the orientation of 
your document or image

Click to print on both 
sides of the page
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■ Printable Area: Lets you center the text or image on the page, or increase the 
printable area of the page. 

Note: Print quality may decline at the edges of the printout when Maximum is 
selected. Before printing a large document, print a single page to test print 
quality.

4. Click OK to close the Page Setup window.

5. From the File menu, select Print. You see this dialog box:

6. Make the following settings:

■ Choose the paper you’re printing on (click the arrow to scroll through the 
Media Type list). If you’re not sure which setting to select, see page 23.

■ Set the Ink option to Color to print a color document or black and white 
photograph. To print a black text document, click Black.

■ Set the Mode option to Automatic. It’s the easiest way to get good printing 
results on all types of paper.

■ Set the slider in the Mode box to Quality or Speed to select high-quality 
printing, fast printing, or an in-between setting.

Tip: For more information about printer settings, click the button.

Select the type of 
paper you loaded

Select the ink 
color

Select higher quality or faster printingSelect Automatic mode
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7. You can also do the following:

■ Click  to reduce/enlarge your printed image, print multi-page layouts, or 
add a watermark.

■ Click  to control background printing and schedule print jobs. 

■ Click , then click Preview to preview your printout.

■ Click  to check your ink levels. 

8. Click Print. 

If you turned on background printing, the window below appears. You can use 
this window to pause, cancel, or restart your print job, stop the print queue, and 
prioritize your print jobs. (If you don’t see this window, select EPSON Monitor 
IV from the Macintosh Application menu in the upper right corner of the screen.)

Note: You can also press the printer’s ) button to cancel a print job in progress.

Click on the current 
print job or 
a waiting print 
job . . .

Click to check 
ink levels

Click to pause printing Click to restart your print job Click to cancel printing

Then click here to 
view details of the 
selected print job and 
control print job 
priorities
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Printing with OS X

If you’re using an OS X compatible printing application, follow the steps below to 
print a document. (If you’re using an application that’s compatible only with 
Macintosh Classic mode, follow the steps on page 15 instead.)

Before you begin, make sure you added your printer to Print Center as described on 
page 58.

1. From the File menu, select Page Setup.

2. Select C82 Series(USB) in the Format for menu.

3. Select the Paper Size, Orientation, and any other settings you want to use and 
click OK.

4. Select Print from the File menu. You see a screen like this:

Select C82 Series(USB) here

Click here and 
select Print 
Settings 
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5. Select Print Settings from the pull-down menu. You see the window:

Tip: For more information about printer settings, click Help. The OS X printer 
driver contains a subset of the settings available with the OS 8.6 to 9.x Macintosh 
printer driver described in this book.

6. Select the following settings:

■ Load the right paper for the kind of document you are printing. If you loaded 
special paper, choose the correct paper type in the Media Type list. If you’re 
not sure which setting to choose, see page 23.

■ Set the Ink option to Color to print a color document or black and white 
photograph. To print a black text document, click Black.

■ Set the Mode option to Automatic. It’s the easiest way to get good printing 
results for most projects.

Select Quality or Speed 
(for faster printing)

Select the type of paper 
you loaded (see page 23)

Select Automatic mode

Select the ink color

Click here to preview your 
printout
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7. You can also choose other print settings by selecting these options in the 
pull-down menu:

■ Copies & Pages, to select the number of copies or a page range

■ Layout, to select page layout options

■ Output Options, to save your print job as a PDF file

■ Color Management, to select ColorSync,® adjust the color controls, change 
the gamma setting, or turn off color adjustments by the printer software

■ Summary, to view a list of all your selections

■ Save Custom Setting, to save your selections for future use.

8. Click Print.

9. To monitor the progress of your print job, click the Print Center icon when it 
appears in the dock on the bottom of your desktop. You see a screen like this:

10. Monitor the progress of your print job or do one of the following:

■ Click the print job, then click Delete to delete the job from the print queue

■ Click the print job, then click Hold to pause printing

■ Click a print job marked “Hold” and click Resume to resume printing

■ If multiple print jobs are listed, click a print job, then click the Priority arrow 
as necessary to reorder the jobs.

Note: You can also press the printer’s ) button to cancel a print job in progress.

11. When you’re finished, close Print Center.

Click here to 
reorder print 
jobs

Click a button to 
Delete, Hold 
(pause), or 
Resume printing
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Customizing Macintosh Print Settings

You can use custom and advanced settings for color matching, printing at a higher 
resolution, or selecting a variety of special effects.

1. On the printer settings window, click Custom.

2. Click the Custom Settings list to open it, and make any of these settings:

■ Text/Graph, for documents that contain both text and color graphs

■ Economy, to save ink when printing on plain paper

■ ColorSync, to match printed output with ColorSync compatible device 
colors.

Macintosh OS 8.6 

to 9.x

Click Custom, then click the 
Custom Settings list

Click Custom, then click the 
Custom Settings list

Macintosh OS X
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3. To access advanced settings, click Custom, then click Advanced (OS 8.6 to 9.x) 
or click Advanced Settings (OS X).

Note: For more information on advanced settings, or instructions on saving them as a 
group so you can reuse them later, click Help (OS X) or (OS 8.6 to 9.x).

To select color management 
settings, select Color 
Management from the Print 
Settings pull-down menu

Click here to select print quality; 
includes Photo RPM, which 
gives the best results on photo 
and glossy paper types

Select various printing options here

Select color management 
settings here

Click here to select print 
quality; includes Photo 
RPM, which gives the 
best results on photo and 
glossy paper types

Select various printing 
options here

Macintosh OS 8.6 to 9.x

Macintosh OS X
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4. OS 8.6 to 9.x: Click OK to save your settings, then click Print.

OS X: Click Print.

Selecting the Correct Paper Type

Your printer automatically adjusts itself for the type of paper 
you select in your printer software. That’s why the paper 
Type setting (Media Type setting for Macintosh) is so 
important. It tells your printer what kind of paper you’re 
using and adjusts the ink coverage accordingly. 

Here are the settings you should choose for your paper:

For this paper . . . Select this paper Type setting . . .

Plain paper or envelopes Plain Paper

EPSON Premium Bright White Paper Bright White Paper

EPSON Photo Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Cards

Photo Quality Ink Jet Paper

EPSON Matte Paper Heavyweight Matte Paper - Heavyweight

EPSON Double-Sided Matte Paper Double-Sided Matte Paper

EPSON Enhanced Matte Paper (Archival 
Matte Paper)

Enhanced Matte Paper

EPSON Glossy Photo Paper (Photo Paper) Glossy Photo Paper

EPSON Premium Semigloss Photo Paper Premium Semigloss Photo Paper

EPSON Ink Jet Transparencies Ink Jet Transparencies
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Maintaining Your Printer

This section describes maintenance procedures to keep your printer working at its best 
and preparation steps for moving your printer. Follow the instructions here for: 

■ “Cleaning the Print Head” (below)

■ “Replacing an Ink Cartridge” on page 27

■ “Aligning the Print Head” on page 34

■ “Cleaning the Printer” on page 36

■ “Transporting the Printer” on page 37

To watch printer movies describing how to clean the print head or replace an ink 
cartridge, double-click the  EPSON Printer Information Center icon on your 
desktop.

Cleaning the Print Head

If your printouts are unexpectedly light, or dots or lines are missing, you may need to 
clean the print head. This unclogs the nozzles so they can deliver ink properly. 
Cleaning the print head uses ink, so clean it only if print quality declines. 

This section explains how to clean the print head using the printer’s Head Cleaning 
utility (available only when the printer is connected directly to your computer, not 
over a network).

You can also clean the print head by holding down the H ink button on the printer for 
three seconds when the red H ink out light is off.

For more information about cleaning the print head, see your Print Show movies; 
double-click the EPSON Printer Information Center icon on your desktop.

Caution: When you don’t turn on your printer for a long time, the print quality can 
decline, so turn it on at least once a month to maintain good print quality.
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Running the Head Cleaning Utility

1. Make sure the printer is turned on but not printing, and the H ink out light is off. 
(If the H ink out light is flashing or on, you may need to replace an ink cartridge; 
see page 27.)

2. Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen). Select Head Cleaning. 

Macintosh OS 8.6 to 9.x: Open your application’s File menu and choose Page 
Setup or Print. Click the Utility button, then click the  Head Cleaning 
button.

Macintosh OS X: Open the Applications folder and double-click EPSON 
Printer Utility. Select C82 Series in the printer list, click OK, and select Head 
Cleaning.

3. Follow the instructions on the screen to clean the print head. Cleaning takes 
about 60 seconds, during which the printer makes some noise and the Ppower 
light flashes. 

Caution: Never turn off the printer while the Ppower light is flashing, unless the 
printer hasn’t moved or made noise for more than 5 minutes.

4. When the Ppower light stops flashing, make sure plain paper is loaded in the 
printer. Then click Print nozzle check pattern (Windows) or Confirmation 
(Macintosh) and follow the on-screen directions to print a nozzle check (see the 
next section for details). 

5. If the nozzle check pattern has no gaps in its lines, click Finish.

If the pattern has any gaps, click Clean to clean the print head again. If you don’t 
see any improvement after cleaning three or four times, check the solutions 
beginning on page 45. You can also turn the printer off and wait overnight—this 
allows any dried ink to soften—and then try cleaning the print head again.
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Examining the Nozzle Check Pattern

Examine the nozzle check pattern you print. It should look something like this:

Each staggered horizontal and straight vertical line should be complete, with no gaps 
in the dot pattern. If your printout looks okay, you’re done. 

If there are gaps in the lines, clean the print head again; see page 25 for instructions.

Replacing an Ink Cartridge

When the red H ink out light is flashing, one of your ink cartridges is low on ink. This 
is a good time to make sure you have a new ink cartridge. When the H ink out light 
stays on, an ink cartridge is empty and you need to replace it.

Caution: You cannot print if any of the ink cartridges are empty. Leave the empty 
cartridge installed in the printer until you have obtained a replacement; otherwise 
the ink remaining in the print head nozzles may dry out.

If the ) paper out or P power light are also flashing or on, check the table on 
page 41. You may have a paper jam or another problem.

When an ink cartridge has been installed in your printer for more than six months, 
you may need to replace it if you notice that your printouts don’t look as good as they 
used to. If print quality doesn’t improve after cleaning and aligning the print head, 
you can replace the cartridge even if the H ink out light isn’t flashing. 
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Checking Your Ink Supply

To check your ink supply, do one of the following:

■ Windows: Double-click the  printer 
icon on your taskbar (in the lower right 
corner of your screen). You see a window 
like the one on the right showing ink levels:

You can also double-click the  Ink 
Monitor icon on the taskbar. The window 
that appears lets you check ink levels and 
also order cartridges online. Just click the 
Buy Now button to launch your web 
browser.

■ Macintosh: 

OS 8.6 to 9.x: Choose File > Print. Click 
the  ink icon.

OS X: Choose Applications > EPSON 
Printer Utility > C82 Series > EPSON 
Status Monitor.

You see a window like the one on the right:

Purchasing Cartridges

Use these EPSON ink cartridges within six 
months of installing them and before the 
expiration date on the package:

■ Black: T032120

■ Cyan: T042220

■ Magenta: T042320

■ Yellow: T042420

Caution: To ensure good results, use genuine EPSON ink cartridges and do not 
refill them. Other products may cause damage to your printer not covered by 
EPSON’s warranty.
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When you need new ink cartridges, contact your dealer or call the EPSON Store  at 
(800) 873-7766, or visit the EPSON Store at www.epsonstore.com (U.S. sales only). 
In Canada, please call (800) 463-7766 for dealer referral.

Ink Cartridge Precautions

Warning: Keep ink cartridges out of the reach of children and do not drink the ink.

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets 
in your eyes, flush them thoroughly with water.

Caution: Don’t remove the cartridge label, 
or ink will leak. 

Don’t remove the green IC chip from the 
cartridge. Installing a cartridge without an 
IC chip can damage the printer. Avoid 
touching the green IC chip, as this can 
damage the ink cartridge.

If you remove an ink cartridge temporarily, 
protect the ink supply port on the bottom of 
the cartridge from dirt and dust. Place it in a 
small box, or, if you have the original packaging, return it to its own box.

Store ink cartridges in the same environment as the printer. Stand the cartridges 
upright, as shown (the label identifying the color should be on the top).

Replacing an Empty or Low Ink Cartridge

Be sure you have a new ink cartridge before you begin. Once you start the ink 
cartridge replacement procedure, you must complete all the steps in one session.

Follow these steps to replace ink cartridges when the red H ink out light is flashing 
or on:

1. Make sure the printer is turned on and not printing. The P power light should be 
on, but not flashing.

2. Lower the output tray and open the printer cover.

SM

Don’t touch this part
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3. Press the H ink button for one 
second. The print head moves to the 
left, and the cartridge that needs to 
be replaced stops under the _ mark. 
The P power light also begins to 
flash. 

Caution: Don’t press the H ink 
button for more than 2 seconds, or 
the printer will start to clean 
the print head.

To avoid damaging the printer, never 
move the print head by hand.

4. Press the H ink button again. 

■ If more than one ink cartridge is empty, the next cartridge moves under the _ 
mark. This happens after you press the H ink button for every ink cartridge 
that needs to be replaced. 

■ If all the empty cartridges have 
been identified, the print head 
moves to the ink cartridge 
replacement position.

Ink 
button
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5. Pinch the front and back tabs of the 
empty cartridge as you lift it out of 
the printer. Don’t take the used 
cartridge apart or try to refill it.

Warning: If ink gets on your hands, 
wash them thoroughly with soap and 
water. If ink gets into your eyes, flush 
them immediately with water.

6. Before you remove the new 
cartridge from its package, shake it four 
or five times.

7. Remove the cartridge from its 
package and lower it into the 
cartridge holder. Push down gently 
until the cartridge is firmly seated.

8. Repeat steps 5 through 7 for each 
cartridge that you need to replace.

9. Close the printer cover and press the H ink button for one second. The printer 
moves the print head and begins charging the ink delivery system.

The P power light flashes and the printer makes noise. Charging takes about one 
minute. When it’s finished, the P power light stops flashing and stays on.

Caution: Never turn off the printer while the Ppower light is flashing, unless the 
printer hasn’t moved or made noise for more than 5 minutes.
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Replacing a Cartridge When Print Quality Declines

Even if the H ink out light isn’t flashing or on, you may need to replace an ink 
cartridge if it’s been installed in your printer for more than six months and print 
quality declines.

Follow these steps to replace old ink cartridges:

1. Print a nozzle check pattern to determine which cartridges need to be replaced:

Windows: Right-click the  printer icon on the Windows taskbar, and then 
click Nozzle Check.

Macintosh 8.6 to 9.x: Open your application’s File menu and choose Print. Then 
click the  Utility button. On the Utility menu, click the Nozzle Check button.

Macintosh OS X: Open your Applications folder and double-click EPSON 
Printer Utility. Select C82 Series in the printer list and click OK. Then click 
Nozzle Check.

2. Follow the instructions on the screen to print the nozzle check pattern. Then 
examine the pattern for gaps in the lines. You only need to replace those colors 
whose lines show gaps.

3. Make sure you have the correct replacement cartridges.

Note: You must have the new ink cartridges before you continue. Once you start 
the ink cartridge replacement procedure, you must complete all the steps in one 
session.

4. Lower the output tray and open the printer cover.

5. Press the H ink button. The print 
head moves to the ink cartridge 
replacement position, and the 
P power light begins to flash.

Note: Don’t press the H ink button 
for more than 2 seconds, or the 
printer will start to clean the print 
head.

Caution: To avoid damaging the 
printer, never move the print head 
by hand.

Ink button
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6. Pinch the front and back tabs of the 
cartridge as you lift it out of the 
printer. Don’t take the used 
cartridge apart or try to refill it. 

Warning: If ink gets on your hands, 
wash them thoroughly with soap and 
water. If ink gets in your eyes, flush 
them immediately with water.

7. Before you remove the new cartridge 
from its package, shake it four or five 
times.

8. Remove the cartridge from its 
package and lower it into the 
cartridge holder. Push down gently 
until the new cartridge is firmly 
seated.

9. Repeat steps 6 through 8 for each 
cartridge you want to replace.

10. Close the printer cover and press the H ink button for one second. The printer 
moves the print head and begins charging the ink delivery system.

The green P power light flashes and the printer makes noise. Charging takes 
about one minute. When it’s finished, the P power light stops flashing and 
stays on.

Caution: Never turn off the printer while the Ppower light is flashing, unless the 
printer hasn’t moved or made noise for more than 5 minutes.
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Aligning the Print Head

If your printouts contain misaligned vertical lines, or you see white or black horizontal 
banding, you may need to align the print head. 

Note: Your printer must be connected directly to your computer (not over a 
network) to use the Print Head Alignment utility.

1. Turn on the printer. Then load plain, letter-size paper.

2. Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen) and select Print Head Alignment.

Macintosh OS 8.6 to 9.x: Open your application’s File menu and choose Page 
Setup or Print. Then click the  Utility button. On the Utility menu, click the 

 Print Head Alignment button.

Macintosh OS X: Open the Applications folder and double-click EPSON 
Printer Utility. Select C82 Series in the printer list, click OK, and then select 
Print Head Alignment.

3. Follow the instructions on the 
screen to print a black vertical 
alignment test page. You see this 
window:

4. Look at the five rows of patterns in 
your printout. For each row, select 
the pattern with the two vertical 
lines most precisely printed on top 
of each other and enter its number 
in the corresponding box on the 
screen.

If you find a perfectly aligned 
pattern for each row, click Next.

If you can’t find an aligned pattern for a row, select the best pattern and click 
Realignment. Then repeat this step.

5. Click Print to print the color vertical alignment sheet.
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6.  Look at the four rows of patterns in 
your printout. For each row, select 
the pattern with the two vertical 
lines most precisely printed on top of 
each other and enter its number in 
the corresponding box on the screen.

If you find a perfectly aligned 
pattern for each row, click Next.

If you find a row that doesn’t have a 
perfectly aligned pattern, select the 
best pattern and click Realignment. 
Then repeat this step.

7. Click Print to print a black 
horizontal alignment sheet. You see 
this screen:

8. In your printout, select the pattern 
with the smallest gap or faintest line 
between the rectangles. Enter its 
number in the box on the screen and 
click Next.

If you can’t find an aligned pattern, 
choose the best pattern and click 
Realignment. Then repeat this step.

9. Click Print to print a color horizontal 
alignment sheet. You see this screen:

10. In your printout, find the pattern 
with the smallest gap or faintest line 
between the rectangles and enter its 
number in the box on the screen. 
Then click Finish.

If can’t find an aligned pattern, 
choose the best pattern and click 
Realignment. Then repeat this step. 
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Cleaning the Printer

To keep your printer working at its best, you should clean it several times a year. 

1. Turn off the printer and wait for the green Ppower light to go out.

2. Unplug the power cord. 

3. Disconnect the printer cable from the printer.

4. Remove all the paper from the sheet feeder.

5. Clean the exterior of the printer with a soft, damp cloth. Keep the printer cover 
closed to prevent water from getting inside.

6. If ink leaks inside the printer, carefully wipe it off with a damp cloth.

Caution: Don’t touch the gears inside the printer.

Make sure you use a soft cloth to clean the printer’s lid; otherwise you may 
scratch it. Don’t use a rough cloth, and never use a hard or abrasive brush to 
clean any part of the printer case.

Never use alcohol or thinner for cleaning; they can damage the printer 
components and case.

Don’t get water on the printer components, and don’t spray lubricants or oils 
inside the printer.

Don’t use any cleaning sheets included with special media; they may jam inside 
the printer.

If ink leaks inside, 
wipe here with a 
damp, lint-free cloth
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Transporting the Printer

If you move your printer some distance, you need to prepare it for transportation in 
its original box or one of a similar size. Follow these steps:

Caution: To avoid damage, always leave the ink cartridges installed when 
transporting the printer.

Be sure to remove the tape used in step 5 after installing the printer in its new 
location.

1. Turn on the printer and wait until the print head locks in the far right position. 
Then press the P power button to turn the printer off.

2. Unplug the power cord.

3. Disconnect the printer cable from the printer.

4. Remove any paper from the printer and remove the paper support.

5. Open the printer cover. Secure 
the ink cartridge holder to the 
printer with tape as shown, then 
close the printer cover.

6. Push in the output tray extensions 
and close the tray.

7. Repack the printer and 
attachments in the original box 
using the protective materials 
that came with it.

Be sure to keep the printer level as 
you move it. 

After transporting the printer, remove the tape securing the print head and test your 
printer. If you notice a decline in print quality, clean the print head (see page 25); if 
output is misaligned, align the print head (see page 34). 

Tape the ink 
cartridge holder to 
the printer case
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Problem Solving

See “Diagnosing Printer Problems” on page 41 to help determine what the cause of 
your printer problem may be. Then see these sections for solutions.

■ “Setup and Software Installation Problems” on page 43

■ “Printer Problems” on page 44

■ “Quality Problems” on page 45

■ “Paper Problems” on page 48

■ “Miscellaneous Problems” on page 48

■ “Uninstalling and Reinstalling Printer Software” on page 50

■ “Where To Get Help” on page 51

Tip: It’s a good idea to check EPSON’s support web site periodically for possible 
updates to your printer driver. Visit http://support.epson.com and check the 
section for your product to see if there is a new driver available, free of charge, 
for downloading to your computer. Download instructions are posted for your 
convenience.
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Printer Parts

Paper support

Printer cover

Output tray extensions

Output tray

Left edge guide

Right edge guide

Ink cartridge holder 
(not removable)

Paper thickness lever

Paper / Cancel Print Job 
button and paper out light

Ink button and ink out 
light

Power button and light
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Diagnosing Printer Problems

You can diagnose some problems by checking the printer’s control panel lights, as 
described in this section, or running a printer check, as described on page 42.

Checking the Control Panel Lights

Follow the guidelines below when you check the control panel lights:

P is on or flashing The Ppower light is on when the printer is ready to print. It flashes 
when the printer is receiving a print job, charging ink, or cleaning the 
print head. It also flashes when the print head moves to the ink 
cartridge replacement position.

) is on The printer is out of paper. Load paper as described on page 7, and then 
press the ) paper button to resume printing.

) is flashing Paper has jammed in the printer. Press the ) paper button to eject the 
jammed paper. If that doesn’t clear the error, open the printer cover and 
remove any paper inside, including torn pieces. Then load a new stack 
of paper and press the ) paper button to resume printing.

H is flashing One of the ink cartridges is low on ink. Follow the instructions beginning 
on page 29 to replace the empty cartridge. If the H ink out light goes on 
after you’ve replaced a cartridge, you may have installed a cartridge your 
printer can’t use. Check the number on the ink cartridge package to 
make sure you’ve installed the correct cartridge.

H is on One of the ink cartridges is out of ink. Follow the instructions beginning 
on page 29 to replace the empty cartridge. If the H ink out light remains 
on after you’ve replaced a cartridge, you may have installed a cartridge 
your printer can’t use. Check the number on the cartridge package to 
make sure you’ve installed the correct cartridge.

H is on and ) is 
flashing

Jammed paper may be blocking movement of the print head, or you 
may have an internal error. Turn off the printer, open the cover, and 
check for any jammed paper. Also, make sure you removed all the 
packing material, as described on the Start Here sheet. Then turn the 
printer back on. If the error isn’t cleared, contact your dealer or EPSON. 
See page 51 for contact information.

) and H are 
flashing

An unknown printer error has occurred. Turn the printer off and contact 
your dealer or EPSON as described on page 51.
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Running a Printer Check

You can run a printer check to determine whether a problem comes from the printer 
itself or some other source. Follow these steps:

1. Make sure both the printer and computer are turned off. Then disconnect the 
interface cable from the printer.

2. Make sure letter-size or larger paper is loaded in the printer.

3. Hold down the ) paper button, then press and release the Ppower button. 
Continue holding down the ) paper button until the Ppower light starts to 
flash, then release it.

The printer prints one page showing its ROM version number, ink counter, and a 
nozzle check pattern. Only the nozzle check pattern is shown below. (If the 
pattern has gaps in its dots, you need to clean the print head; see page 25.)

4. To end the check, turn the printer off after it prints the check page. Then 
reconnect the interface cable and turn on your printer and computer.

If the check page prints, the problem probably lies in your software settings, the 
interface cable, or your computer. Another possibility is that your printer software 
may not be installed correctly.

If the check page doesn’t print, you may have a problem with your printer. Try the 
suggestions in “Problems and Solutions” beginning on page 43. If nothing seems to 
work, contact your dealer or EPSON as described on page 51.

P is off The printer is not receiving power. Try these solutions:
■ Make sure the printer is turned on.
■ Turn off the printer, plug in the power cord securely, and turn the 

printer on again.
■ Make sure the outlet is working and is not controlled by a switch or 

timer. If in doubt, try another outlet.
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Problems and Solutions

Here are some troubleshooting tips if you have any problems setting up your printer, 
installing software, or printing.

Setup and Software 
Installation Problems

The printer makes noise after ink 
cartridge installation.

■ The first time you install ink 
cartridges, the printer must charge 
its ink delivery system for about 90 
seconds. Wait until charging 
finishes (the Ppower light stops 
flashing) before you turn off 
the printer or it may charge 
improperly and use excess ink the 
next time you turn it on. If the 
printer stops moving or making 
noise, but the P power light is still 
flashing after 5 minutes, turn off 
the printer. If the light is still 
flashing when you turn it back on, 
contact EPSON as described on 
page 51.

■ Make sure no packing material 
remains in the printer. Turn off 
the printer, wait a moment, then 
turn it back on to clear the error.

You’re having problems installing 
the printer software.

■ Make sure your printer is turned 
on and the printer cable is securely 
connected at both ends. Then 
carefully follow the installation 
instructions for your system. 
(You’ll find them on the Start Here 
sheet or beginning on page 53.) 
Also make sure your system meets 
the requirements beginning on 
page 59.

■ Close your other applications, 
including any screen savers and 
virus protection software, and 
install again.

■ For Windows NT or 2000, if you 
see an error message or your 
software doesn’t install correctly, 
you may not have software 
installation privileges. Contact 
your System Administrator.

■ If your printer icon (C82 Series) 
doesn’t appear in the Macintosh 
Chooser, you may have an 
extension conflict. Turn off any 
unnecessary extensions and restart 
your computer.
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■ For Windows 2000 or XP, don’t 
select Block under Control Panel> 
System> Hardware> Driver 
Signing; select Ignore or Warn 
instead.

■ If you’re using Windows 98, Me, 
2000, or XP with a USB 
connection, make sure your system 
was not upgraded from Windows 
95; the USB driver may not install 
correctly.

■ Make sure the Universal Serial Bus 
Controller is working properly. See 
your Windows online help system 
for details. 

■ If you’re printing over a network, 
see your on-screen Reference Guide 
for instructions on configuring your 
printer for use on a network.

■ In Windows, make sure your 
printer is selected as the default 
printer in the Printers utility.

Printer Problems

The Ppower light is on, but nothing 
prints.

■ Make sure the interface cable 
is connected securely and that 
the cable meets the system 
requirements on page 59 or 
page 60.

■ Run a printer check as described 
on page 42. If the check page 
prints, make sure your printer 
software is installed correctly. 

■ If you’re printing on a network, you 
need to set up your printer for 
network printing, as described in 
your on-screen Reference Guide.

The printer sounds as though it is 
printing, but nothing prints.

■ The print head nozzles may need 
cleaning; see page 25 for 
instructions.

■ The printer won’t operate properly 
if it’s tilted or at an angle. Place it 
on a flat, stable surface.

Your printer makes noise when you 
turn it on or after it has been sitting 
for awhile.

Your printer is performing routine 
maintenance.

Printing is too slow.

Make sure your system meets the 
requirements beginning on page 59. If 
you’re printing a high-resolution image, 
you need more than the minimum 
requirements listed. 

You may also need to:

■ Clear space on your hard disk or 
run a defragmentation utility.
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■ Close open applications that you’re 
not using.

■ Increase your system’s memory 
(RAM).

For the fastest printing, try these tips:

■ Select Draft as the Quality Type 
(Windows) or set the 
Quality/Speed slider to Speed 
(Macintosh). 

■ In the Advanced dialog box, turn 
Super MicroWeave® off 
(Macintosh only) and turn High 
Speed on.

■ If your printer is connected to a 
USB hub, disconnect any unused 
USB devices.

■ If you’re using the parallel port, 
enable ECP/DMA mode. See your 
computer documentation or 
contact the manufacturer for help.

Quality Problems

You see banding (light lines).

■ Clean the print head; see page 25. 

■ Select the correct paper Type 
(Windows) or Media Type 
(Macintosh); see page 23 for 
guidelines.

■ Select a higher print quality and 
turn off High Speed mode; see 
page 14 (Windows) or page 22 
(Macintosh) for details.

■ The printable side of the paper 
should be face up. It’s usually 
whiter or shinier.

■ The ink cartridges may need 
replacing. To replace them, see 
page 32.

■ Try using Automatic mode 
(Macintosh only). See page 16 
(Macintosh OS 8.6 to 9.x) or 
page 19 (Macintosh OS X).

■ Run the Print Head Alignment 
utility; see page 34 for instructions.

■ Set the paper thickness lever to the 
m position. Set the lever to the ^ 

position when you print on thicker 
paper or envelopes. You may also 
need to turn off High Speed in the 
printer software.
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Your printout is blurry or smeared.

■ Make sure your paper isn’t damp or 
curled, or loaded face down (the 
printable side should be face up). 
Reload new paper face up.

■ Use a support sheet with special 
paper, or try loading your paper 
one sheet at a time.

■ Make sure your paper meets the 
specifications listed in the on-screen 
Reference Guide.

■ Use EPSON papers for proper 
saturation and absorption 
of genuine EPSON inks. 

■ Run the Print Head Alignment 
utility. See page 34 for instructions.

■ For most papers, set the paper 
thickness lever to the m position.

■ Remove each sheet from the output 
tray after printing, especially when 
you’re printing on transparencies.

■ Let your print dry completely 
before you handle it. Prints made 
on glossy photo paper take longer 
to dry. Follow the instructions 
included in your media pack.

■ Load a new sheet of plain paper and 
press the ) paper button to eject 
it. Do this several times. If you still 
have a problem, ink may have 
leaked inside the printer. Open 
the printer cover and wipe the area 
circled in the illustration below 
with a soft, clean cloth.

Your printout is faint or has gaps in 
the image.

■ Clean the print head; see page 25 
for instructions. 

■ The ink cartridges may be old or 
low on ink; see page 27. 

■ Select the correct paper Type 
(Windows) or Media Type 
(Macintosh) for your paper. See 
page 23 for guidelines.
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■ Make sure your paper isn’t 
damaged, old, dirty, or loaded face 
down. If it is, load new paper face 
up. For best results, use genuine 
EPSON paper.

You see wrong or missing colors.

■ Make sure Black Ink Only is off 
(Windows) or Color ink is selected 
(Macintosh), even when printing 
black and white photographs.

■ Clean the print head; see page 25 
for instructions.

■ The ink cartridges may be old or 
low on ink; see page 27.

■ For best results, use genuine 
EPSON ink cartridges.

■ Try turning off PhotoEnhance.™ 
Also check if you’re using a special 
effect that alters image colors, like 
Sepia. 

■ Try using Automatic mode 
(Macintosh only); see page 16 (OS 
8.6 to 9.x) or page 19 (OS X).

■ The color profiles built into your 
printer software automatically 
reference your monitor profile. 
Make sure that your monitor is 
calibrated correctly.

■ Try experimenting with the 
Gamma setting on the Advanced 
dialog box; see page 14 (Windows) 
or page 21 (Macintosh).

■ The colors produced by DuraBrite 
inks may look slightly different 
than those produced by ordinary 
dye-based ink.

■ Due to the nature of pigment inks, 
lighting conditions can affect the 
appearance of printer output. For 
example, a print viewed in daylight 
may appear to have a slightly 
different color balance when viewed 
under tungsten lighting. Your 
printer software was designed to 
represent color accurately when 
prints are illuminated with a D50 
(daylight) light source.

■ Your printed colors can never 
exactly match your on-screen 
colors. However, you can use a 
color management system to get as 
close as possible.

Your printout is grainy.

■ Use a higher quality paper, or select 
a higher Quality Type (Windows; 
page 11) or Print Quality 
(Macintosh; page 21).

■ Align the print head; see page 34 
for instructions.

■ Increase the image resolution or 
print it in a smaller size; see your 
software documentation.



48 Problem Solving

Some parts of your print are not as 
glossy as others.

Because of the nature of pigment inks, 
the degree of gloss may be uneven on 
glossy photo papers. Surface gloss 
decreases with greater pigment 
saturation.

Paper Problems

Paper doesn’t eject fully or is 
wrinkled.

■ If the paper doesn’t eject fully, you 
may have set the wrong paper size. 
Press the ) paper button to eject 
the paper, then select the correct 
paper size in your application or 
printer software.

■ If it’s wrinkled when it ejects, the 
paper may be damp or too thin.

Paper doesn’t feed correctly or jams 
in the printer.

■ If paper doesn’t feed correctly, 
remove it from the sheet feeder. 
Fan the edges of the sheets, reload 
them against the right edge, then 
slide the left edge guide to fit lightly 
against the paper.

■ If paper jams, press the ) paper 
button for several seconds to clear 
the jam. If that doesn’t work, turn 
off the printer and gently pull the 
paper forward (toward the output 

tray) to pull it out. Reload the 
paper and press the m paper button 
to resume printing.

If your paper jams frequently:

■ Use new, smooth, high-quality 
paper, loaded printable side up.

■ Don’t load paper above the arrow 
mark on the left edge guide.

■ If you’re printing on both sides of 
the paper, try loading fewer sheets.

■ Place the paper against the right 
edge and slide the left edge guide 
against it, but not too tightly. 

Miscellaneous 
Problems

The image is inverted.

Turn off the Mirror (Windows) setting 
or Flip Horizontal setting (Macintosh) 
in the printer software. Also check the 
mirror setting in your application 
program.

The printer prints blank pages.

■ Make sure your printer is selected 
in your application, or as the active 
printer in the Macintosh Chooser.

■ Clean the print head; see page 25 
for instructions.
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The margins are incorrect.

■ Make sure the paper settings are 
correct for your paper size. See 
page 11 (Windows), page 15 
(Macintosh OS 8.6 to 9.x), or 
page 18 (Macintosh OS X).

■ Choose the correct margins for 
your paper size. The margins must 
be within the printable area of the 
page. See “Printer Specifications” in 
your on-screen Reference Guide.

■ Make sure your paper is positioned 
next to the right side of the feeder 
and the left edge guide is snug 
against the other side. Don’t load 
paper above the arrow on the left 
edge guide.

Image size or position is incorrect.

Make sure paper and layout options are 
set correctly.

You see incorrect characters.

■ Make sure the interface cable is 
securely connected and meets the 
system requirements on page 59 or 
page 60. 

■ Make sure your printer is selected 
in the Print window (Windows), 
the Macintosh Chooser (Macintosh 
OS 8.6 to 9.x), or Print Center 
(Macintosh OS X).

■ If you’re using a switch box or USB 
hub with your printer, connect the 
printer directly to your computer 
instead.

Too many copies are printing.

Make sure the Copies option in your 
printer software or application is not set 
for multiple copies.

There are scratch marks on your 
print.

If you’re printing on glossy photo 
paper, prints have a tendency to scratch 
if not handled properly. Don’t place 
objects on top of your prints, and be 
careful not to scratch them with your 
fingernails. For best results, frame your 
prints under glass.
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Uninstalling and Reinstalling Printer 
Software

You may need to uninstall and then reinstall your printer driver and utilities if, for 
example, you upgrade your Windows operating system. You don’t need to uninstall 
your other photo software or the EPSON Printer Information Center.

Windows

1. Click Start, and select Programs or All Programs.

2. Point to Epson or EPSON Printers, then select EPSON Printer Software 
Uninstall.

3. In the next window, make sure EPSON Stylus C82 Series is selected and click 
OK. Then follow the on-screen instructions.

4. Restart your computer, then see the Start Here sheet or the instructions beginning 
on page 53 to reinstall your software.

Macintosh OS 8.6 to 9.x

1. Insert your printer software CD-ROM in your drive. 

2. Double-click the  EPSON icon in your CD-ROM window. (You may need to 
double-click the EPSON CD-ROM icon on your desktop to open the window.) 
You see the Main Menu.

3. Click Install Printer Driver. On the Installer screen, click the arrow in the Easy 
Install list at the top and select Uninstall. Then click the Uninstall button at the 
bottom and follow the on-screen instructions.

4. Restart your Macintosh, then see the Start Here sheet to reinstall your software. 

Macintosh OS X

1. Open the Applications folder, then the Utilities folder.

2. Double-click Print Center to open it.
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3. Select C82 Series(USB) in the printer list and click the Delete button.

4. Restart your Macintosh, then see page 57 for instructions on reinstalling your 
software.

Where To Get Help

If you need help with your printer, see the contact information below. For help using 
any other software with your printer, see your software’s documentation for technical 
support information.

EPSON Technical Support

EPSON provides technical assistance 24 hours a day through the electronic support 
services and automated telephone services listed in the following table:

To speak to a technical support representative, dial:

■ U.S.: (562) 276-7525, 6 AM to 8 PM, Pacific Time, Monday through Friday and 
7 AM to 4 PM, Saturday. 

■ Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Toll or long distance charges may apply.

Service Access

World Wide Web From the Internet, you can reach EPSON Support at 
http://support.epson.com. At this site, you can download 
drivers and other files, look at product documentation, access 
troubleshooting information, and receive technical advice 
through e-mail.

Automated 
Telephone Services

A variety of automated help services are available 24 hours a 
day, seven days a week. To use these services, you must 
have a touch tone telephone and call (800) 922-8911. Your 
EPSON SoundAdvice Express Code is 70400. Use this 
code to quickly select the EPSON Stylus C82 in EPSON 
SoundAdvice.

SM
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Before you call, please have the following information ready:

■ Product name (EPSON Stylus C82)

■ Product serial number (located on the back of the printer)

■ Proof of purchase (such as a store receipt) and date of purchase

■ Computer configuration

■ Description of the problem

You can purchase ink cartridges, paper, manuals, and accessories from EPSON at 
(800) 873-7766, or visit www.epsonstore.com (U.S. sales only). In Canada, please 
call (800) 463-7766 for dealer referral.



Installing Software for Windows 2000, 95, NT 4.x, and Macintosh OS X 53

Installing Software for 
Windows 2000, 95, NT 4.x, and 
Macintosh OS X

Follow the instructions in this section for:

■ “Installing Printer Software for Windows 2000” below

■ “Installing Printer Software for Windows 95 and NT 4.x” on page 56

■ “Installing Printer Software for Macintosh OS X” on page 57

Installing Printer Software for 
Windows 2000

Before you begin, complete the instructions for setting up your printer on the Start 
Here sheet.

1. Turn on your computer. (Make sure your printer is still on.)

2. Wait until you see the Found New Hardware screen. Then put the EPSON 
CD-ROM in your drive.
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3. After a moment, click Next. You see a screen indicating that Windows has found 
an unknown device.

4. Click Next.

5. Click Next again on the following screen. Wait while the files are copied to your 
computer.

6. Click Finish when you see this screen:
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7. Read the license agreement and click Agree to continue with the installation. You 
see this screen:

8. Make sure you’ve loaded letter-size paper in your printer, then click Print a Test 
Page to check that your printer is set up correctly.

9. Optionally, click Install EPSON Software Film Factory and follow the 
on-screen instructions to install the software.

10. Click Install Manual and Printer Movies and follow the on-screen directions to 
place a shortcut to the EPSON Printer Information Center on your desktop.

11. Click Exit. When you see the EPSON Product Registration screen, register your 
printer as instructed.

You’re ready to start printing! See the instructions beginning on page 10.
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Installing Printer Software for Windows 95 
and NT 4.x

Before you begin, complete the instructions on the Start Here sheet for setting up your 
printer.

Note: Use a parallel cable to connect the printer to your computer. Windows 95 
and NT 4.x do not support a USB connection.

1. Turn on your computer. (Make sure your printer is still on.)

2. Put the EPSON CD-ROM in your drive.

Caution: If you see the Add New Hardware Wizard, click Cancel. You can’t install 
your software that way.

3. Read the license agreement and click Agree to continue with installation.

4. When you see this screen, click Install Printer Driver. Wait while the files are 
copied to your computer.

5. Click OK when you see a message that setup is complete.

6. Optionally, click Install EPSON Software Film Factory and follow the 
on-screen instructions to install the software.
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7. Click Install Manual and Printer Movies and follow the on-screen directions to 
place a shortcut to the EPSON Printer Information Center on your desktop.

8. Click Exit. When you see the EPSON Product Registration screen, register 
your printer as instructed.

9. Restart your computer.

You’re ready to start printing! See the instructions beginning on page 10.

Installing Printer Software for 
Macintosh OS X

Before you begin, complete the instructions on the Start Here sheet for setting up your 
printer.

1. Make sure your printer is on, then start your Macintosh in OS X. When you see 
your Macintosh icons, put the EPSON CD-ROM in your drive.

2. Double-click the EPSON CD-ROM icon to open its window. Then double-click 
 C82Series.

3. If you set up an administrator password when you installed OS X, you see this 
screen. Click the  icon, enter your administrator password, and click OK. At 
the next screen, click Continue.

Click here
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4. Read the license agreement and click Continue, then click Agree.

5. Select the OS X drive where you want to install your printer software, then click 
Continue.

6. Click Install on the Easy Install screen and follow the on-screen instructions to 
install the printer software and restart your Macintosh.

7. Open the Applications folder, then open the Utilities folder. Double-click Print 
Center.

8. If you see a message that you have no printers available, click Add.

9. If your printer is already listed in the Printer List, close Print Center and go to 
step 10.

Otherwise, click Add Printer. Then select EPSON USB in the pull-down menu 
at the top of the window, select your printer in the Printer List, and click Add. 
Close Print Center.

10. Optionally, double-click the  Film Factory Installer icon and follow the 
on-screen instructions to install the software.

11. Double-click the  Printer Movies and Manual icon and follow the 
instructions to place a shortcut to the EPSON Printer Information Center on 
your desktop. (You may have to close the Film Factory window to see the icon.)

Now you’re ready to print! For instructions, go to page 18.

Note: To print from Macintosh Classic applications as well as OS X applications, 
start your Macintosh in OS 9 and follow the instructions in the Start Here sheet to 
install the OS 9 printer software.
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Requirements and Notices

This chapter includes system requirements, safety instructions, legal notices, and other important 
information.

Windows System Requirements

To use your printer and its software, your system should have: 

■ A Microsoft Windows compatible PC with a Pentium®-equivalent processor, 233 MHz or faster, 
recommended

■ Windows XP, Windows Me, Windows 2000, Windows 98, Windows 95, or Windows NT® 4.x

■ 64MB RAM (128MB recommended)

■ 100MB available hard disk space (200MB recommended)

■ VGA or better display adapter and monitor (SVGA for Windows XP)

■ CD-ROM or DVD drive for installing the printer software

■ Parallel connection: a high-speed, bidirectional IEEE-1284 compliant parallel cable, up to 10 feet 
long (3 meters); the cable must have a D-SUB, 25-pin, male connector for your computer, and a 
36-pin, Centronics® compatible connector for the printer.

USB connection: a computer with preinstalled Windows XP, Me, 2000 or 98, and a 
Windows-compliant USB port and shielded USB “AB” cable.

Caution: Using an improperly shielded USB cable may cause the printer to malfunction.
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Macintosh System Requirements

To use your printer and its software, your system should have: 

■ An Apple® iMac™ series or Power Macintosh® G3 or G4 with built-in USB port

■ Mac® OS 8.6 through 9.x; OS X 10.1 or later (Mac OS 9.1 or better recommended)

■ For Mac OS 8.6 through 9.x: 32MB RAM (64MB recommended)
For Mac OS X: 128MB RAM (256MB recommended)

■ 100MB free hard disk space (200MB recommended)

■ VGA display or better

■ CD-ROM or DVD drive for installing the printer software

■ A shielded USB “AB” cable.

Caution: Using an improperly shielded USB cable may cause the printer to malfunction.
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ENERGY STAR Compliance

As an ENERGY STAR Partner, EPSON has determined that this 
product meets the ENERGY STAR guidelines for energy 
efficiency. The EPA ENERGY STAR office equipment program is 
a voluntary partnership with the computer and office equipment 
industry to promote the introduction of energy-efficient personal 
computers, monitors, printers, fax machines, and copiers in an 
effort to reduce air pollution caused by power generation.

Important Safety Instructions

Before using your printer, read the following safety instructions to make sure you use the printer safely 
and effectively:

■ Be sure to follow all warnings and instructions marked on the printer.

■ Use only the type of power source indicated on the printer’s label.

■ Connect all equipment to properly grounded power outlets. Avoid using outlets on the same 
circuit as photocopiers or air control systems that regularly switch on and off. 

■ Place the printer near a wall outlet where the plug can be easily unplugged.

Placez l’imprimante près d’une prise de contacte où la fiche peut être débranchée facilement.

■ Do not let the power cord become damaged or frayed. 

■ If you use an extension cord with the printer, make sure the total ampere rating of the devices 
plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total 
ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere 
rating.

■ Keep your printer and computer system away from potential sources of electromagnetic 
interference, such as loudspeakers or cordless telephone base units.

■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.

■ Leave enough room around the printer for sufficient ventilation.

■ Do not place the printer near a radiator or heating vent or in direct sunlight.

■ Place the printer on a flat, stable surface that extends beyond the printer base in all directions. The 
printer will not operate properly if it is tilted or at an angle.

■ Turn off and unplug the printer before cleaning. Clean with a damp cloth only. Do not spill liquid 
on the printer.

■ Always turn the printer off using the P power button. The P power light flashes briefly and then 
goes off. Don’t switch off the power strip or unplug the printer until the P power light is off.
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■ Do not block or cover the openings in the printer’s case or insert objects through the slots. 

■ Except as specifically explained in this manual, do not attempt to service the printer yourself. 

■ Unplug the printer and refer servicing to qualified service personnel under the following 
conditions:

If the power cord or plug is damaged; if liquid has entered the printer; if the printer has been 
dropped or the case damaged; if the printer does not operate normally or exhibits a distinct change 
in performance. Adjust only those controls that are covered by the operating instructions.

Ink Cartridge Safety Instructions

■ Keep ink cartridges out of the reach of children and do not drink the ink. 

■ Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply 
port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them 
immediately with water.

■ Do not put your hand inside the printer or touch the cartridge during printing.

■ Do not move the print head by hand. You may damage the printer.

■ Install the ink cartridge immediately after you remove it from its plastic package. Leaving the 
cartridge unpacked for a long time before use can result in reduced print quality.

■ Do not use an ink cartridge beyond the date printed on the cartridge carton. For best results, use 
up the ink cartridges within six months of first installing them.

■ Store ink cartridges in a cool, dark place.

■ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room 
temperature for at least three hours before using it.

■ Do not dismantle the ink cartridges or try to refill them. This could damage the print head.

■ Do not touch the green IC chip on the side of the cartridge. This may affect normal operation and 
printing.

■ If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and 
store it in the same environment as the printer. Note that there is a valve in the ink supply port, 
making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that 
the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.

■ Before transporting the printer, make sure the print head is capped in the far right position and the 
ink cartridges are in place. Tape the ink cartridge holder to the printer case to make sure it remains 
in the proper position.
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FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio or television reception. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause interference to radio 
and television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

■ Reorient or relocate the receiving antenna.

■ Increase the separation between the equipment and receiver.

■ Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.

■ Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC 
Certification of this device and may cause interference levels which exceed the limits established by the 
FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment 
interface cable with this device. If this equipment has more than one interface connector, do not leave 
cables connected to unused interfaces. Changes or modifications not expressly approved by the 
manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
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Declaration of Conformity
According to 47CFR, Part 2 and 15 for Class B Personal Computers and 

Peripherals; and/or CPU Boards and Power Supplies used with Class B Personal 
Computers:

We: EPSON AMERICA, INC. 

Located at: MS: 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806-2469
Telephone: (562) 290-5254 

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 
15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative 
unit tested and found to be compliant with the standards. Records maintained continue to reflect the 
equipment being produced can be expected to be within the variation accepted, due to quantity 
production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the 
following two conditions: (1) this device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired operation.

Trade Name: EPSON

Type of Product: Ink Jet Printer

Model: EPSON Stylus C82: B171A
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Epson America, Inc. Limited Warranty
What Is Covered: Epson America, Inc. (“Epson”) warrants to the first retail purchaser that the EPSON 
printer covered by this limited warranty statement, if purchased and used in the United States or 
Canada, conforms to the manufacturer’s specifications and will be free from defects in workmanship 
and materials for a period of one (1) year from the date of original purchase. Epson also warrants that 
the consumable ink cartridges enclosed with the printer will perform to the manufacturer’s specified 
usage, which usage may expire before the expiration of the limited warranty for the EPSON printer. 
For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your EPSON printer prove defective during the 
warranty period, please call the EPSON Connection  at (562) 276-7525 (U.S.) or (905) 709-2567 
(Canada) for warranty repair instructions and return authorization. An Epson service technician will 
provide telephone diagnostic service to determine whether the printer requires service. If service is 
needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If 
Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, 
freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. 
Possessions). Shipments to other locations will be made freight collect. You are responsible for securely 
packaging the defective unit and returning it to Epson within five (5) working days of receipt of the 
replacement. Epson requires a debit or a credit card number to secure the cost of the replacement 
printer in the event that you fail to return the defective one. If your printer is being repaired, Epson will 
direct you to send your printer to Epson or its authorized service center, where the printer will be fixed 
and sent back to you. You are responsible for packing the printer and for all costs to and from the 
Epson authorized service center. When warranty service involves the exchange of the printer or a part, 
the item replaced becomes Epson property. The replacement printer or part may be new or refurbished 
to the Epson standard of quality, and, at Epson’s option, may be another model of like kind and 
quality. Epson’s liability for replacement of the covered printer will not exceed the original retail selling 
price of the covered printer. Exchange products and parts assume the remaining warranty period of 
your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty covers only normal use in the United States and 
Canada. This warranty is not transferable and will not apply to products purchased from an end user. 
This warranty does not cover any color change or fading of prints or reimbursement of materials or 
services required for reprinting. This warranty does not cover damage to the EPSON product caused 
by parts or supplies not manufactured, distributed or certified by Epson. This warranty does not cover 
ribbons, ink cartridges or third party parts, components, or peripheral devices added to the EPSON 
product after its shipment from Epson, e.g., dealer or user-added boards or components. Epson is not 
responsible for warranty service should the Epson label or logo or the rating label or serial number be 
removed or should the product fail to be properly maintained or fail to function properly as a result of 
misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as 
fire, flood, and lightning, improper electrical current, software problems, interaction with non-Epson 
products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot be 
identified or reproduced, you will be held responsible for the costs incurred.
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THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF 
ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR 
FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE 
EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS 
AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED 
ABOVE. UNLESS STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE 
BY ANY OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS 
WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL 
BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, 
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE 
OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH 
OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some 
jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the 
above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and 
you may have other rights which vary from jurisdiction to jurisdiction. 

Epson America, Inc. ■ P. O. Box 93012 ■ Long Beach, CA 90809-3012
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Index

A

Accessories, 29, 52
Advanced settings, 14, 22 to 23
Aligning print head, 34 to 35
Archival Matte Paper, 23
Automatic mode, Macintosh, 16, 19

B

Background printing, 17
Banding, 45
Basic printing

Macintosh, 15 to 20
Windows, 10 to 13

Best Photo setting, 11
Blank pages, 48
Blurry images, 46
Browser, 4
Buttons, 25

C

Cable, printer, 59 to 60
Cancel Print Job button, 13, 17, 20, 40
Cancelling printing, 13, 17, 20, 40
Characters, incorrect, 49
Checking printer, 42
Cleaning

print head, 25 to 26
printer, 36
sheets, 36

Color Management settings, 14, 20, 22
Color problems, 47
ColorSync, 20, 21
Control panel, 41 to 42

Controlling printing
Macintosh, 20
Windows, 13

Customizing settings, 14, 21

D

Default settings, Windows, 13
Documentation, 3 to 5
Double-Sided Printing setting, 12, 15
Draft setting, 11, 45
DuraBrite inks, 1

E

Economy setting, 21
Edge Smoothing setting, 14, 22
Electronic manual, 4 to 5
Envelopes, printing on, 8 to 9
EPSON

accessories, 29, 52
help, 51 to 52
papers, 23
PhotoCenter, 2
Printer Information Center, 2, 4 to 5
Store, 29, 52
warranty, 65

Exif Print, 2

F

Faint images, 46
Film Factory, 2
Flip Horizontal setting, 22, 48
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G

Gamma setting, 14, 22

H

Head Cleaning utility, 25 to 26
Help, EPSON, 51 to 52
High Speed setting, 14, 22, 45
High-resolution images, 47

I

Incorrect characters, 49
Incorrect colors, 47
Ink cartridge

checking ink levels, 28
replacing, 27 to 33
safety instructions, 62

Ink Jet Transparencies, 23
Ink level, 13, 28
Ink Monitor icon, 28
Ink out light, 27, 41
Installation problems, 43 to 44
Installing

OS X software, 57 to 58
Windows 2000 software, 53 to 55
Windows 95 and NT 4.x software, 56 to 57

Inverted image, 48

J

Jams, paper, 48

L

Layout problems, 49
Layout settings, 12, 17, 20
Lever, thickness, 45, 46
Lights, 25, 41 to 42

M

Macintosh
background printing, 17
basic printing, 15 to 20
customizing settings, 21 to 23
installing OS X software, 57 to 58
layout settings, 17, 20
previewing printout, 17, 19
scheduling print jobs, 17, 20
system requirements, 60
uninstalling software, 50 to 51
USB, 60

Maintaining printer, 25 to 36
Margins, incorrect, 49
Matte Paper Heavyweight, 23
Media Type setting, 23

Mac OS 8.6 to 9.x, 16
Mac OS X, 19

Mirror images, 12, 48
Monitoring ink level

Macintosh, 17, 28
Windows, 13, 28

Movies, Print Show, 2, 4
Moving printer, 37

N

Network printing, 44
Noise, printer, 44
Nozzle check pattern, 26 to 27, 42

O

Orientation setting, 11, 15, 18

P

Page Setup, Macintosh, 15, 18
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Paper
feeding problems, 48
orientation, 11, 15, 18
thickness lever, 40, 45, 46
Type setting, 11, 23

Paper out light, 41
Paper Size setting, 11, 15, 18
Photo Quality Ink Jet Paper, 23
Photo RPM setting, 14, 22
Photo setting, 11
PhotoCenter, EPSON, 2
PhotoEnhance setting, 12, 16, 22
Premium Bright White Paper, 23
Previewing printout, 12, 17, 19
Print Center, 20
Print dialog box, 10
Print head

aligning, 34 to 35
cleaning, 25 to 26

Print Head Alignment utility, 34 to 35
Print quality problems, 45 to 47
Print Show movies, 2, 4
Printable Area setting, 16
Printer

cable, 59 to 60
check, 42
cleaning, 36
control panel, 41 to 42
icon, 26, 28, 32, 34
maintaining, 25 to 36
noise, 44
parts, 40
problems, 41 to 42, 44 to 45
status, 13, 20
transporting, 37

Printer Information Center, 2, 4 to 5
Printing

controlling, 13, 20
Macintosh, 15 to 23
on envelopes, 8 to 9
slow, 44
Windows, 10 to 14

Problems
installing software, 43 to 44
miscellaneous, 48 to 49
paper feeding, 48
print quality, 45 to 47
printing, 44 to 45

Progress Meter, 13

Q

Quality Type setting, 11, 45
Quality/Speed setting, 16, 19

R

Reference Guide, 4 to 5
Reverse Order setting, 12
RPM technology, 1

S

Safety instructions, 61 to 62
Service, 51 to 52
Slow printing, 44
Smears, 46
Software

installing, 53 to 58
problems, solving, 43 to 44
summary, 2
uninstalling, 50 to 51

SoundAdvice, 51
Super MicroWeave setting, 22, 45
Support, 51 to 52
System requirements, 59 to 60
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T

Technical support, 51 to 52
Text & Image setting, 11
Text setting, 11
Text/Graph setting, 21
Thickness lever, 45, 46
Transparencies, 23
Transporting printer, 37
Troubleshooting, 39 to 48

U

Uninstalling software, 50 to 51
USB, 59, 60
Utilities

Head Cleaning, 25 to 26
Print Head Alignment, 34 to 35

W

Warranty, 65
Windows

customizing settings, 14
default settings, 13
installing software, 53 to 57
layout settings, 12
paper Type, 11, 23
previewing printout, 12
printer status, 13
printing with, 10 to 14
system requirements, 59
USB, 59

World Wide Web, 51
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EPSON Ink Jet Papers

Use EPSON paper and inks to get the best results from your EPSON printer! EPSON papers are 
specially designed to work with EPSON quick drying inks. 

Premium Bright White Paper 

Premium Bright White Paper has a sleek, ultra-smooth surface, and 
108+ brightness. This paper delivers crisp black text and vivid, 
colorful images. It’s perfect for everyday printing—especially 
two-sided documents.

Double-Sided Matte Paper

Double-Sided Matte Paper is coated on both sides with a flat matte finish 
for photographic quality output. It’s the ideal media when you need 
high-quality double-sided printing for brochures, newsletters, or flyers.

Glossy Photo Paper 4 × 6

Here’s a water-resistant paper with a glossy finish for your photo keepsakes. It’s 
available in a variety of sizes, but you’ll find the 4 × 6 inch size is just right for 
your digital snapshots.

Featuring EPSON’s exclusive new DuraBrite™ ink technology for 
superior clarity, lightfastness, and water resistance.

For more information on other EPSON products and fun project 
ideas, look for the EPSON Print Lab  Series at 
www.printlabseries.com.

See the inside back cover for a list of EPSON papers and ordering information.
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How To Order EPSON Ink and Paper

To order EPSON ink cartridges and paper, call (800) 873-7766 or visit the EPSON Store at 
www.epsonstore.com (U.S. sales only). In Canada, call (800) 463-7766 for dealer referral.

EPSON Ink Cartridges

Black T032120

Cyan T042220

Magenta T042320

Yellow T042420

EPSON Papers

Notes: The names of EPSON papers do not always match the paper type settings in your 
printer software. See the table on page 23 or the instructions that came with your paper 
to select the correct paper type setting.

EPSON is always adding new papers to this list. Visit the EPSON Store at 
www.epsonstore.com and check out the latest media.

Paper name Size Part number

EPSON Premium Bright White Paper Letter (8.5 x 11 inches) S041586

EPSON Photo Quality Ink Jet Paper Letter (8.5 x 11 inches) S041062

Legal (8.5 x 14 inches) S041067

A4 (8.3 x 11.7 inches) S041061

EPSON Photo Quality Ink Jet Cards A6 (4.1 x 5.8 inches) S041054

EPSON Double-Sided Matte Paper Letter (8.5 x 11 inches) S041568

EPSON Enhanced Matte Paper (Archival Matte 
Paper)

Letter (8.5 x 11 inches) S041341

EPSON Matte Paper Heavyweight Letter (8.5 x 11 inches) S041257

EPSON Glossy Photo Paper (Photo Paper) Letter (8.5 x 11 inches) S041141 (20)/ S041649 (50)/ 
S041271 (100)/ S041272 (500)

4 × 6 inches S041134 (20)/ S041671 (50)

A4 (8.3 x 11.7 inches) S041140

EPSON Premium Semigloss Photo Paper Letter (8.5 x 11 inches) S041331

EPSON Ink Jet Transparencies Letter (8.5 x 11 inches) S041064
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